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About this guide
Welcome to the Quest Privilege Manager for Windows Administrator Guide. This guide instructs system
administrators on how to use Privilege Manager. Inside you will find in-depth instructions on how to prepare
your environment for least privileged use, maintain a least privileged environment, run reports, and interface
with Microsoft tools.
For more information, refer to these additional resources:

For system administrators:
l

Privilege Manager Quick Start Guide: Learn about the Privilege Manager system requirements and
how to set up the console, server, and client. Also read an overview of the product’s key features and the
wizards that will help you use them.

l

Privilege Manager for Windows Console: Find more information on the Getting Started screen under
the Additional Resources tab.

For end users with the Privilege Manager client service installed on their computers:
l

Privilege Manager for Windows User Guide: Learn the basics of using Privilege Manager for Windows,
including how to use self-service elevation, instant elevation, and view rules.
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What is Privilege Manager?
Editions
Components
Giving users administrator rights creates security risks but must be weighed against constant help desk calls for
basic operations like updating Adobe Reader, Java, or simply changing the time zone on desktops.
Privilege Manager lets you grant selected privileges to users so they can update their own computers,
reducing help desk calls while maintaining a secure network. By automating user privilege settings, Privilege
Manager keeps users working; this enables you to focus on higher priority tasks, for exceptional resource and
time savings.
As a system administrator, you can use Privilege Manager to elevate and manage user rights quickly and
precisely with validation logic targeting technology. Use privilege elevation rules from the community, or create
your own rules and allow administrator-level access to specific applications. You can also enable your end
users to request elevated privileges for specific applications through self-service and instant elevation.

Editions
Privilege Manager is available in the following editions:
l

Privilege Manager Community: This edition is free and does not require a license. You can collaborate,
brainstorm new elevation rules, share rules with other users, and provide bug reports and enhancement
requests to Quest Software.

l

Privilege Manager Professional: This edition requires a paid license and includes additional security,
discovery, and reporting capabilities, as well as technical support from Quest Software.

l

Privilege Manager Professional Evaluation: This edition is the free 30-day trial period for Privilege
Manager Professional. If you do not buy a license after 30 days, the software will revert to the lesserfeatured Community edition. You won't have the Professional features, but you can keep the Community
edition just for trying Privilege Manager.
When reverting back to the Community edition, you will need to re-save all computer-based Group Policy
object (GPO) rules as user-based. Computer-based rules will no longer work on the client-side once the
trial expires.
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Components
There are three software components included with Privilege Manager: the console, server and client.

Console
The Privilege Manager console, installed via PAConsole_Pro.msi, is a management application. It is installed
on a domain computer (server/workstation) and is used to create and manage rules within the Group Policy. Any
user who has permission to edit a GPO can use the console to set privileges.

Server
The Privilege Manager server, installed via the console, is a service which has several functions. It can deploy
the client, collect and report on data, and discover and process applications that require elevated privileges.

Client
The Privilege Manager client, installed via PAClient.msi, is a service that runs on each client computer. It
applies the rules created in the console by monitoring processes as they are launched on the client and
elevates or lowers the privileges for processes that are configured to be monitored. This is done by injecting an
administrative token into the process or revoking it.
Microsoft Active Directory and Group Policy are used to distribute Privilege Manager rules to client computers.
Privilege Manager can modify privileges only for a standard user account, not a guest account. Elevated
privileges can be revoked even if the user is a local admin.
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Installing Privilege Manager
System requirements
Installing the console
Configuring the server
Installing the client
Upgrading
Uninstalling
To complete the Privilege Manager installation, you will need to install the console, configure the server, and
install the client. Then you can start using Privilege Manager based on your Windows rights within the Group
Policy Management Console. If you do not have enough rights on an object, a message will tell you that
access is denied.

System requirements
Please refer to the Privilege Manager for Windows Quick Start Guide for the list of System Requirements.

Installing the console
The console must be installed on a computer that is joined to the domain and run under a user account that has
the rights to change at least one GPO. The console displays GPOs based on the security context of the user that
is logged on.

Using the console Windows Installer file
Please refer to the Privilege Manager for Windows Quick Start Guide for instructions on using the console
Windows Installer file.
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Opening the console
To start the Privilege Manager console on the host:
1. Go to Start > All Programs > Quest > Privilege Manager > Privilege Manager, or
2. Select the

Privilege Manager shortcut icon on the Start menu.

Applying a license
You can apply a license upon initial start-up or later. Otherwise, if your trial has expired, you’ll only be able to
access the Community edition.

To apply a license when you start the console for the first time:
1. A window will display asking you to apply a license.
2. Click Yes if you are going to apply a Privilege Manager Professional or Professional Evaluation license.
Browse to the license file and click Open.
Or,
3. Click No to access the Privilege Manager Community Edition that does not require a license.

To apply a license in the console after initial start-up:
1. Click Help > About in the menu.
2. Click the Licenses tab.
3. Click the Apply License File button.
4. Highlight the product name and click the Update License button.
5. Browse to the license file and click Open and then OK.
6. If you are upgrading, you may need to follow the additional steps detailed in the Upgrading section.

Viewing GPOs
To view the GPOs that you have access to:
1. Switch from the Setup Tasks > Getting Started window to the Group Policy Settings > All
GPOs window.
2. You will see the GPOs you have access to:
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Note: If you do not see the domain tree when the Group Policy Settings section is selected, check
that the default domain is selected in the Setup Tasks > Select Target Domains window.

Selecting target domains
The Privilege Manager console is initially configured to allow you to manage the privilege elevation settings for
the domain to which the local computer belongs. In addition, the console also allows you to manage other
domains in your forest.
For Windows Privilege Manager to work across multiple domains within a single forest, the appropriate domain
permissions must be configured and an Enterprise Admin Active Directory account must be used with the
Privilege Manager console.
NOTE: The recommendation for multiple domains in a single forest is for each domain within the forest to
host a completely separate installation of Privilege Manager.

To customize the number of your forest’s domains available in the Group Policy Settings pane:
1. In the Getting Started section of the navigation pane, select Setup Tasks and then click
Target Domains in the right pane.

Select

2. In the window that will open, check/uncheck the domain names as desired.
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3. (Optional) Click the Select DC button to open the Select Domain Controller dialog. Specify the exact
domain controller that the console will communicate with.
The list of the domains and GPOs will change accordingly.
NOTE: You can create the GPO rules only on a domain where you have write permissions for the GPOs.

Configuring the server
Available only in Privilege Manager Professional and Professional Evaluation editions.
After installing the console, a server must be configured. Configuring the server will set up the back-end
services needed to automatically deploy the client, as well as enable reporting, discovery and remediation.

Using the Server Configuration Wizard
Please refer to the Privilege Manager for Windows Quick Start Guide for instructions on using the Server
Configuration Wizard.

Modifying the server
You must configure the settings for the server on the console where it was installed. However, any administrator
with the rights to a specific GPO can update its data collection settings. Also, the administrator running the
console can view reports of data collected by any server by selecting Browse and the preferred server from the
Privilege Manager Server Configuration screen (under Setup Tasks > Configure a Server).
If you need to change the reporting database settings, i.e., connect to another instance, modify the
authentication parameters, or set up a new data collection service:
1. Use the Privilege Manager Server Configuration screen to remove the server.
2. Restart the wizard to reinstall the service and set the SQL database settings.

Privilege Manager for Windows 4.1 Administrator Guide
Installing Privilege Manager

12

Removing the server
If you do not want to use a server, you can clear its settings and/or remove it from a
host computer:
1. Open the Privilege Manager Server Configuration screen (under Setup Tasks > Configure a Server).
2. Select Clear the server name to clear the settings which the console uses to connect to reporting
information. The locally running server will not be stopped or disabled. This will not uninstall the server.
3. Click Remove the Privilege Manager Server from this computer to uninstall the server from the local
computer. When you remove the server:
a. You will stop the web data collection service;
b. The shared folder with the client file will not be shared anymore; and
c. The database will not receive data sent by the corresponding clients until a new server is
installed, provided that it is installed within the network timeout parameters.

To remove a server running remotely:
1. Connect to the computer that hosts the server.
2. Remove the server via the Privilege Manager Server Configuration screen.
Note: If a domain administrator or the administrator of a nested organizational unit (OU) uninstalls the
server, they may render the reporting function unavailable on other console computers or computers
downstream from the parent OU. Also, if you have reinstalled the server, reports will generate starting
from the last installation.

Installing the client
Once the console is installed, you can deploy clients to the computers on your domain in one of
the following ways:
l

Client Deployment Settings Wizard: Deploy or uninstall clients on your computers in one pass.
Available only in Privilege Manager Professional and Professional Evaluation editions.

l

Client Windows Installer file: Use PAClient.msi to install the client locally on a computer
(administrative privileges are required).

l

Microsoft Group Policy Management Console: Use login scripts or other software deployment
techniques for mass-deployment.

Using the Client Deployment Settings Wizard
Please refer to the Privilege Manager for Windows Quick Start Guide for instructions on using the Client
Deployment Settings Wizard.
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Using the client Windows Installer file
To use the client Windows Installer file to install the client locally on a computer:
1. To locate the client MSI setup file, open the console.
2. Click Additional Resources > Open Client Installation Folder. The client file will display in a
browser window.

3. Check that the client has been successfully deployed onto the computer. Ensure that:
a. The CSEHost.exe process is running;
b. The client record is shown in the Add/Remove Programs tool; and
c. The Privilege Manager icon and the right-click menu are available in the system tray on the
client computer.
New GPO rules created via Privilege Manager will be applied to client computers following a
group policy update.

Using the Group Policy Management
Console
To install clients on your domain via the Microsoft Group Policy Management
Console (GPMC):
1. Copy the PAClient.msi file to a network share that can be read by all users. Or, just share the
file folder (a share with the PAClient.msi file is configured automatically upon server
configuration).
a. To locate the client MSI setup file, open the console.
b. Click Additional Resources > Open Client Installation Folder. The client file will display
in the browser window.
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2. Right-click on Group Policy Objects and select New from the pop-up menu to open the Group
Policy Management Console on the server to create a new GPO.
3. Enter a name for the new GPO and click OK.
4. Right-click on the new GPO and select Edit to open it.
5. In the Group Policy Management Editor, select Computer Configuration > (in Windows Server
2008) Policies > Software Settings > Software installation. In the right pane, right-click on the
new GPO, and select New > Package.
a. If the client distribution GPO is computer-based (defined under Computer Configuration),
enable the “Always wait for the network at computer startup and logon” policy (located
in Computer Configuration > (in Windows Server 2008) Policies > Administrative
Templates > System > Logon). Otherwise, the client will install after the second reboot of
the client computer.
b. If the client distribution GPO is user-based (defined under User Configuration), then the
client will install after the first logon.
6. In the dialog box that will open, browse to the PAClient.msi file on the network share where it
was copied to.
a. Use the File name field to specify the client location in the Universal Naming Convention
(UNC) format:
\\computername\sharename\filename.msi
b. Click Open.
7. Select Assigned in the Deploy Software dialog.
8. Assign the new GPO to a domain or OU.
a. To assign it to a domain, right-click on the domain in GPMC and select Link an
Existing GPO.
b. Select the GPO in the dialog box and click OK.
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9. Check that the client has been successfully deployed onto the computer. Ensure that:
a. The CSEHost.exe process is running;
b. The client record is shown in the Add/Remove Programs tool; and
c. The Privilege Manager icon and the right-click menu are available in the system tray on
the client computer.
New GPO rules created via Privilege Manager will be applied to client computers following
a group policy update.

Upgrading
Privilege Manager components are only compatible with other components of the same version.
Upgrading ensures that all of the GPO rules and reporting configurations you created with earlier
versions will still be available.

To upgrade prior versions:
1. Run the Privilege Manager setup file (PAConsole_Pro.msi) and follow the Privilege Manager Console
Windows Installer.
a. If a message displays, Some files that need to be updated are currently in use, click OK.
b. Once you complete the upgrade, exit the installer.
2. Open the console and if necessary, apply a license. For more information, see Opening the console on
page 10 and Applying a license on page 10.
3. If an error message notifies you that the ScriptLogic PA Reporting Service has the wrong, manual,
startup type, either:
a. Go to the Windows Services console and set the ScriptLogic PA Reporting Service to start
automatically, or
b. Click OK in the message window to reset the service to start automatically. If the restart fails, click
NO, and then restart the Privilege Manager for Windows console.
Note: The automatic server upgrade may be unavailable if the ScriptLogic PA Reporting Service
is not running.
4. If the console detects that the server component is installed on a remote computer, it will instruct you to
launch on the remote computer.
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5. If a message prompts you to upgrade your server and database (installed locally with the reporting
functionality of some prior Privilege Manager versions):
a. Click OK and follow the Privilege Manager Server Configuration Wizard to:
i. Install missing SQL Server components from the Internet;
ii. Back up your database; and
iii. Configure a shared folder for client mass deployment.
b. Click Finish to save the results and exit the wizard.
c. If a message displays that the Privilege Manager Host Service that needs to be updated is
currently in use, click OK to ignore the message.
d. To upgrade later, open the Privilege Manager Server Configuration Wizard and confirm that
you are running the upgrade process before you configure the server.
e. Until you have upgraded the server and database, you will have problems installing the
server locally.
f. For more information, see Configuring the server on page 12.
6. Re-configure your client data collection settings, if necessary.
a. Select a GPO from the Group Policy Settings section.
b. Switch to the Advanced Policy Settings tab.
c. Double-click Client Data Collection Settings to configure settings using the Client Data
Collection Settings Wizard. For more information, see Configuring client data collection
on page 20.
7. After you upgrade, By Digital Certificate rules will be saved as By Path to the Executable rules.
8. To upgrade clients, install the newer version over the older one. For more information, see Installing the
client on page 13.

Uninstalling
You must have administrative privileges to uninstall the console and client from a local computer.

To uninstall Privilege Manager components:
1. Use the Windows Control Panel tool. The uninstaller will completely remove all of the data.
2. Once Privilege Manager for Windows is removed, its rules will no longer apply.
For more information, see Removing the server on page 13.
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Product Improvement Program
To assist in the development of new features, as well as drive future improvements, we have implemented a
Product Improvement Program. Feedback from this program provides Product Management with valuable
insight into how our products are being used. This information is essential to help the R&D team prioritize
existing enhancement requests within the roadmap of the each product. Participation is voluntary, and no
personal contact information is ever collected.

How do I participate in the Product Improvement Program?
What if I change my mind?
There is an option in Privilege Manager that can be used to verify or change your participation at any time.
Select the Help menu and then click on Product Improvement Program to change your participation option.

How will the collected information be used?
Information collected will be used to develop new features and improve Privilege Manager.

Where is the data being stored?
The data is stored on a secure server within the USA and will be accessed only be the members of the Privilege
Manager R&D team.

What information is collected?
l

Privilege Manager features usage data such as console configuration settings

l

System information such as operating system, processor, and memory installed

l

Domain information such as number of users, servers, and workstations being managed

l

Browser type and version

l

Product information such as version

l

License information such as type and number of seats
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How does the Product Improvement Program work?
You choose to participate and allow Privilege Manager to send usage data, associated with an anonymous
user ID from your computer. If you are offline at any time, the data will be sent the next time an internet
connection is available.

How long will collected data be stored?
We will store the collected data on our secure server for as long as the Product Improvement Program
is in place.

Will I receive spam if I participate in the Product
Improvement Program?
You will not receive any e-mail regarding the Product Improvement Program, regardless of whether you
participate. We do not collect personally identifiable information.

Do I need an Internet connection?
An Internet connection is required for participation. However, it can be an intermittent connection. When an
internet connection becomes available, the information is automatically transmitted with minimal impact to
your system.

Can I see the data that is collected before it is transmitted?
No, the information cannot be displayed on the customer side. The collection of the desired data occurs
seamlessly in the background without affecting the product. Additionally, all formatting and processing of the
collected data are done post transmission.

How long will my participation in the program last?
Information is actively collected as long as you use the product version for which you have agreed to participate
or until you decide to end your participation.

How is my privacy protected?
We take many precautions in protecting the information that is collected and transmitted. You can learn more
about how we handle user information by reviewing our Privacy Policy.
Since no personally identifiable information is collected, the anonymous data will not be meaningful to anyone
outside of our company.
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5

Configuring client data collection
Using the Client Data Collection Settings Wizard
Available only in Privilege Manager Professional and Professional Evaluation editions.
Run the Client Data Collection Settings Wizard so that you can compile reports, support discovery, and launch
on-demand features.

Using the Client Data Collection
Settings Wizard
Client data collection settings will only apply on computers running a client.
Before configuring client data collection settings, you must configure a server on your domain. For more
information, see Configuring the server on page 12.

To use the Client Data Collection Settings Wizard to set up, modify, or discard settings:
1. Open the wizard:
a. Open the Client Data Collection Settings Wizard from the Setup Tasks section. It will always
show the default settings, or
b. Double-click Client Data Collection Settings on the Advanced Policy Settings tab of the target
GPO. The changes made within the wizard will be saved here.
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2. Enable the Client Data Collection Settings on the State tab.
a. Choose Enabled, otherwise the settings won't apply to the selected GPO.
b. Choose Not Configured to enable child GPOs to inherit settings from their parent.
3. Define the server on the Settings tab. This server will receive data from the clients of the target GPO.
a. Click the Browse button to locate a server via Active Directory.
b. Use the Test button to test the selected server's connection to the ScriptLogic PA Reporting
Service. If the test fails, check to see if there are network or firewall problems.
c. Click the Clear the server name link if you want to configure another server. The displayed
service will not be uninstalled.
Note: To prevent data transfer issues between the server and linked clients, check that the port
you have selected is open for incoming connections on the server. Port 8003 is the default port for
server installation.
4. Use the Advanced Settings on the Settings tab to set these data transfer parameters:
l

Maximum Sleep Time (in seconds) sets the stagger time period within which every client will send its
data to the data collection service. This value is set to 60 seconds by default.

l

Send Retries defines the number of retries that are made if an attempt to connect to the web service
fails. This number is set to 1 by default.

l

Network Timeout (in seconds) sets how many seconds a client should wait to stop sending data if it
does not reach the target. This value is set to 600 seconds by default.

l

Maximum Records Per Transaction indicates how many portions of cached data the client sends. This
value is set to 0 by default, which indicates an unlimited number. To reduce the load on the server side,
you can increase the value to 1 or 2. This may be useful on large networks where each client computer
generates many records and a client may not be able to connect to the data collection service because it
is too busy processing data collection transactions.

5. Click Next to use validation logic to target the settings to specific client computers or user accounts
within the GPO, or click Finish to save your settings and quit.
If an error message indicates that the target GPO has not been selected:
a. Click OK to close the message window.
b. Open the GPO tab and select the desired GPO.
6. Click Save on the GPO toolbar to save the new settings.
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Adjust the parameters with which clients will send their data to the ScriptLogic PA Reporting data collection
web service to your specific needs. The web service supports collecting data from a significant number of clients
running concurrently.
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Configuring instant elevation
Using the Instant Elevation Wizard
Available only in Privilege Manager Professional and Professional Evaluation editions.
To grant on-demand administrative privileges to a group of trusted users and audit their actions, use the Instant
Elevation Wizard.

Using the Instant Elevation Wizard
Before you configure instant elevation settings, ensure the following components are set up:
1. The client is running on the computers you want to apply the settings to;
2. The server is configured and running with the port that you have selected allowed for incoming data (the
default port is 8003); and
3. Client data collection settings are enabled for the selected GPO.

To use the Instant Elevation Wizard to set up, modify, or discard privileges:
1. Open the wizard:
a. Open the Instant Elevation Wizard from the Setup Tasks section. It will always show the default
settings, or
b. Double-click Instant Elevation Settings on the Advanced Policy Settings tab of the target GPO.
The changes made within the wizard will be saved here.
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2. Enable the Instant Elevation Settings on the State tab.
a. Choose Enabled, otherwise the settings won't apply to the selected GPO.
b. Choose Not Configured to enable child GPOs to inherit settings from their parent.
3. Use the Groups tab to alter the settings. By default, users of the target GPO will automatically inherit the
administrator's settings (BUILTIN\Administrators).
4. Complete the advanced options in the Privileges and Integrity tabs.
5. Click Next to use validation logic to target the settings to specific client computers or user accounts
within the GPO, or click Finish to save your settings and quit.
If an error message indicates that the target GPO has not been selected:
a. Click OK to close the message window.
b. Open the GPO tab and select the desired GPO.
6. Click Save on the GPO toolbar to save the new settings.

7. Users can click the
Elevate! button to launch privileged applications without interruptions. The button
is available on the context menu of Windows Explorer objects that require elevated privileges to start-up,
including: .bat, .cmd, .exe, .js, .lnk, .msc, .msi, .msp, .pl, .ps1 or .vbs (.lnk is for
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shortcuts).

8. Run an Instant Elevation Report to view the processes that have been launched. For more information,
see Instant Elevation Report on page 76.
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7

Configuring self-service elevation
Using the Self-Service Elevation Request Settings Wizard
Selecting how users access the request form
Using self-service notifications
Using the Self-Service Elevation Request Processing Wizard
Using the Console Email Configuration screen
Available only in Privilege Manager Professional and Professional Evaluation editions.
To enable users to request permissions to use privileged applications, use the Self-Service Elevation Request
Settings Wizard. Whenever a user attempts to run an application which requires administrative permissions for
which they do not have rights, they will be asked if they would like to send a request to their administrator for
permission to run it.
You can select how users access the request form and set up self-service notifications to email you, the help
desk, and your manager of each request. Then, you can process the request within the Self-Service
Elevation Requests section of the console and email your decision to the user, using the Console Email
Configuration screen.

Using the Self-Service Elevation
Request Settings Wizard
Before you configure self-service elevation request settings, ensure the following components
are set up:
1. The client is running on the computers you want to apply the settings to;
2. The server is configured and running with the port that you have selected allowed for incoming data (the
default port is 8003); and
3. Client data collection settings are enabled for the selected GPO.
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To use the Self-Service Elevation Request Settings Wizard to set up, modify, or discard
privileges:
1. Open the wizard:
a. Open the Self-Service Elevation Request Settings Wizard from the Setup Tasks section. It will
always show the default settings, or
b. Double-click Self-Service Elevation Request Settings on the Advanced Policy Settings tab of
the target GPO. The changes made within the wizard will be saved here.

2. Enable the Self-Service Elevation Requests Settings on the State tab.
a. Choose Enabled, otherwise the settings won't apply to the selected GPO.
b. Choose Not Configured to enable child GPOs to inherit settings from their parent.
3. Use the Settings tab for Selecting how users access the request form.
4. Click Next to use validation logic to target the settings to specific client computers or user accounts
within the GPO, or click Finish to save your settings and quit.
If an error message indicates that the target GPO has not been selected:
a. Click OK to close the message window.
b. Open the GPO tab and select the desired GPO.
5. Click Save on the GPO toolbar to save the new settings.
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Selecting how users access the
request form
Use the Settings tab of the Self-Service Elevation Request Settings Wizard to select how end users access
the request form and set up email confirmation and notification settings. You can combine the following options:
OPTION

ACTION

Automatically ask users if they
would like to request that a privilege
elevation rule be created whenever
they attempt to launch applications
which require privilege elevation to
run.

Once a user closes the User Account Control (UAC) window, a SelfService Elevation Request Prompt will display.
Note: Not all applications which display UAC windows will
automatically pop up a Self-Service Elevation Request Form.
You can allow the user to manually submit self-service
requests by enabling the "Add a Windows explorer shell"
option described below. Windows Installer files (.msi) will
not automatically trigger Self-Service Prompts, so the SelfService Elevation Request Form will need to be manually
triggered by users.

This option is enabled by default.

Allow users to hide or disable these
prompts.

l

Users can select whether the request form will display in the
future by checking the In the future, don't show me this
when I try to run applications that need approval checkbox.

l

A user on a client computer can re-enable/disable the prompt
using the Display Self-Service Prompts icon on the context
menu of the system tray.

This option is enabled by default.

Note: This setting does not affect the Self-Service Elevation
Request Form launched with the
Elevate! button. It only
affects the request forms displayed automatically.
Add a Windows explorer shell
extension allowing the user to rightclick on a program or shortcut in
order to request that a privilege
elevation rule be created for that
program.
This option is enabled by default.
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OPTION

Allow user to specify the email
address where a confirmation email
should be sent once the
administrator has processed the
request for the privilege elevation
rule.

ACTION
l

Users can click the
Elevate! button to launch privileged
applications without interruptions. The button is available on
the context menu of Windows Explorer objects that require
elevated privileges to start-up, including: .bat, .cmd,
.exe, .js, .lnk, .msc, .msi, .msp, .pl, .ps1 or
.vbs (.lnk is for shortcuts).

l

Users can click the
Elevate! button to launch the SelfService Elevation Request Form or instant elevation, if it is
enabled.

The user can enter an email address into the corresponding text
field.
By default, the field is pre-populated with the email address of the
user who is logged in (provided that it is specified in Active
Directory).

(If this option is not checked, the
email will be sent to the user's
Exchange account as found in
Active Directory.)
This option is disabled by default.
Send an email notification to the
administrator whenever a user
submits a Self-Service Elevation
Request.
This option is disabled by default.

Enter the Email Address for the administrator and/or the help desk
or other recipients. Use the + button to add entries and the x button
to remove them.
By default, the Email Subject is pre-populated with Privilege
Manager Self-Service Elevation Request as the subject line. You
can enter your own subject and press the Reset button to reset it to
the default.
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Using self-service notifications
If you would like to receive an email when a user on a client computer submits a Self-Service Elevation
Request Form, you can set up a self-service notification. You can configure it to go to multiple recipients,
including you, your manager, and/or the help desk. In addition, you can set the subject line to meet the
requirements of your help desk.

To set up self-service notifications:
1. Configure the server.
a. Use the Privilege Manager Server Setup Wizard to configure the Server Email Notification
Configuration settings on the first screen of the wizard.
b. If you have previously completed the wizard, the other screens will automatically populate.
c. Refer to the Privilege Manager for Windows Quick Start Guide for step-by-step instructions.
2. Configure the recipient.
a. Use the Settings tab on the Self-Service Elevation Request Settings Wizard to configure the
Email Notification Settings.
b. For more information on the wizard, see Using the Self-Service Elevation Request Settings
Wizard on page 26.
c. For more information on setting up Email Notification Settings, see Send an email notification to
the administrator whenever a user submits a Self-Service Elevation Request.
3. Check your email for the self-service notification, containing information on the user, the request, and the
client’s computer.
4. Accept or reject the user's request Using the Self-Service Elevation Request Processing Wizard.
5. Inform the end user of your decision Using the Console Email Configuration screen.

Using the Self-Service Elevation
Request Processing Wizard
Shortly after a user on a client computer has submitted a Self-Service Elevation Request Form, you can view
and/or process it within the Self-Service Elevation Requests section of the console (provided that your
environment is properly configured according to the Maximum Sleep Time setting).
You can only view data stored in the database of the server that is selected in the server configuration (Setup
Tasks > Configure a Server).
When processing a self-service elevation request, you can either create a rule to elevate privileges for the
process or deny the request. You can then email your decision to the user using the Console Email
Configuration screen.

To view or process self-service elevation requests:
1. Open the Self-Service Elevation Requests section from the navigation pane of the console. The
requests will be displayed in the window to the right.
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2. Click the Display requests button to list the self-service elevation requests submitted by users, based on
the default filter settings shown in the Applied Filters section on the top of the screen.
3. Select a request in the Self-Service Elevation Requests grid below. Use the grid's column headers to
sort the requests.
By default, you'll see:
a. Requests to elevate any type of applications;
b. Requests sent during the last 30 days; and
c. Requests that have never been processed with the Process request button from the
current section.
4. Use the Applied Filters wizard to modify the list. You can create multiple shared filter sets and
save settings that other administrators can use. For more information, see Using the Applied Filters
Wizard on page 79.
5. Select a record and then click the Process request button to open the Self-Service Elevation Request
Processing Wizard.
6. On the first tab of the wizard, view the details for a process that failed to start, as well as the reason for
requesting elevation privileges. Click Next.
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7. Select whether you want to create a rule to elevate the privileges for this process or deny the request.
a. If you approve the request, the Create Rule wizard will display to create a rule for the requested
process. By default, the rule will be created for a specific user at a specific computer, and the
Administrators group (stored within the BUILTIN\Administrators Active Directory OU) will be
added to the rule. Use the Validation Logic tab to modify this setting.

b. Once a request has been processed and a rule has been created for it or it has been denied, the
Processed Action column will display a rule created or ignored value.
c. To view ignored requests or requests for which the rules were created, change the Process Date
of Item filter on the Applied Filters Wizard from "None: Item has not been processed" to the
corresponding Date Range.
8. Select whether or not to email your decision to the user. This feature requires that you set up the
Console Email Configuration settings.
9. Click Finish to save.
10. The rule created from the request will be added to the selected GPO with a default name.
11. Select Export to export the list of requests presented on the grid. The list will be saved as an .xls file.

After the rule has been created:
1. The rule will be added to the target GPO of the Group Policy Settings section; and
2. The rule will apply after the GPO settings are updated on the client computer.

Using the Console Email
Configuration screen
If you would like an email message to be sent to the user when you have approved or denied their self-service
elevation request, you can configure the settings using the Console Email Configuration screen found under
Setup Tasks.

To configure the server to send your self-service elevation request approval or refusal:
1. Select Console Email Configuration from the Setup Tasks section.
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2. Fill in the following fields:
a. Host Name: Enter the SMTP Server name of the email account from which you are going to send
your emails.
b. SMTP Port: Enter the port number.
c. SMTP User Name and Password: If necessary, enter the authentication information and check
the SSL checkbox.
d. From Email: Enter the corresponding email.
3. Click Send Test Email to send an email to the account specified within the From Email field.
a. If Privilege Manager succeeds in sending the email, the corresponding message will display.
b. Log into an email program with the corresponding account and locate the sent email with
Privilege Manager Test Email in the subject.
4. Click OK to save the settings and quit.
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Configuring temporary session
elevation
Using the Temporary Session Elevation Passcode Manager
Available only in Privilege Manager Professional and Professional Evaluation editions.
Temporary Session Elevation (TSE) allows an administrator to generate elevation passcodes that can provide
end users the ability to temporarily elevate the privileges of any process or application on his/her machine. The
passcodes will work for both on-network and off-network machines, even if there is not an active internet
connections.

Using the Temporary Session
Elevation Passcode Manager
Before you configure temporary session elevation settings, ensure the following
components are set up:
1. The client is running on the computers you want to apply the settings to;
2. The server is configured and running with the port that you have selected allowed for incoming data (the
default port is 8003); and
3. Client data collection settings are enabled for the selected GPO.
4. The client is enabled to use offline passcodes to create temporary elevated sessions (enabled in the
Client Deployment Settings wizard).

To use the Temporary Session Elevation Wizard to set up privileges:
1. Open the wizard:
a. Open Passcode Manager from the Temporary Session Elevation section on the navigation
pane of the console.
2. Create a new passcode:
a. Click New to start the Instant Elevation TSE passcode generator.
3. Enable the Instant On Demand Privilege Elevation settings on the State tab.
a. Choose Enabled, otherwise the settings won't apply to the selected GPO.
b. Choose Not Configured to enable child GPOs to inherit settings from their parent.
4. Use the Groups tab to alter the settings. By default, users of the target GPO will automatically inherit the
administrator's settings (BUILTIN\Administrators).
5. Complete the advanced options in the Privileges, Integrity and Validation Logic tabs.
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6. The Passcode is created on the next tab, Passcode.
a. Enter a Title to describe the passcode.
b. Enter a Maximum allowed usage. This is the number of times the passcode can be used
before expiring.
c. Enter a Duration. The duration is the amount of time the passcode will remain active for
once activated.
d. Optionally, select the checkbox toe End all elevated processes (and child processes) when
Passcode duration expires. If selected, this will close all windows that were opened with a
Temporary Session Elevation passcode.
e. Click Export to file to save the passcode for end user use.
7. Click Finish to complete the wizard.
a. The passcode should be delivered to the user for usage.
8. Run a Temporary Session Elevation Usage Report to view the processes that have been launched. For
more information, see Temporary Session Elevation Request Report on page 76.
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8

Configuring privileged application
discovery
Using the Privileged Application Discovery Settings Wizard
Processing discovered privileged applications
Available only in Privilege Manager Professional and Professional Evaluation editions.
Use the Privileged Application Discovery Settings Wizard to collect information about the privileged
applications used over your network during a specified time period. By default, once this feature is enabled, it is
set to collect information for one month, but you can adjust the setting.

Using the Privileged Application
Discovery Settings Wizard
Before you configure privileged application discovery settings, ensure the following components
are set up:
1. The client is running on the computers you want to apply the settings to;
2. The server is configured and running with the port that you have selected allowed for incoming data (the
default port is 8003); and
3. Client data collection settings are enabled for the selected GPO.

To use the Privileged Application Discovery Settings Wizard to set up, modify, or
discard settings:
1. Open the wizard:
a. Open the Privileged Application Discovery Settings Wizard from the Setup Tasks section. It will
always show the default settings, or
b. Double-click Privileged Application Discovery Settings on the Advanced Policy Settings tab of
the target GPO. The changes made within the wizard will be saved here.
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2. Enable the Privileged Application Discovery Settings on the State tab.
a. Choose Enabled, otherwise the settings won't apply to the selected GPO.
b. Choose Not Configured to enable child GPOs to inherit settings from their parent.
3. Use the Settings tab to set the period during which the settings will apply and the data will be collected
(a month by default).
4. Click Next to use validation logic to target the settings to specific client computers or user accounts
within the GPO, or click Finish to save your settings and quit.
If an error message indicates that the target GPO has not been selected:
a. Click OK to close the message window.
b. Open the GPO tab and select the desired GPO.
5. Click Save on the GPO toolbar to save the new settings.

Processing discovered privileged
applications
Once a privileged process has started (or failed to start) on a client computer, the corresponding information will
be sent to the server and display in the Privileged Application Discovery section of the console (provided that
your environment is properly configured according to the Maximum Sleep Time setting).
You can only view data stored in the database of the server that is selected in the server configuration (Setup
Tasks > Configure a Server).
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When processing a discovered privileged application, you can either create a rule for it so that a user without
elevated privileges can launch it, or choose to mark it as processed so that it will not display in the list (unless
the filter is specifically set to display it).
Use the Generate Rules wizard to automatically create a number of rules for different types of applications in
one pass. Rules are created based on the preferences with which the application was started. You can select
an application and view its preferences in the Privileged Applications Discovered grid.

Using the Generate Rules Wizard
To view discovered privileged applications and generate rules for them:
1. Open the Privileged Application Discovery section from the navigation pane of the console. The
applications will be displayed in the window to the right.

2. Click the Display applications button to list the privileged applications and other processes that were
started (or failed to start), based on the default filter settings shown in the Applied Filters section on the
top of the screen.
3. Select an application in the Privileged Applications Discovery grid below. Use the grid's column
headers to sort the applications.
By default, you'll see:
a. Any type of privileged applications;
b. Privileged applications that were discovered during the last 30 days; and
c. Privileged applications that have no generated rule in the current section, or are marked as
ignored in it.
4. Use the Applied Filters wizard to modify the list. You can create multiple shared filter sets and
save settings that other administrators can use. For more information, see Using the Applied Filters
Wizard on page 79.
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5. Select a record and then click the Generate rules button to open the Generate Rules Wizard wizard.
a. On the first tab of the wizard, specify your rule type preferences. Click Next.
b. Add validation logic preferences into the rule, if necessary. The selected preferences will be used
to create the corresponding validation logic type. Click Next.
c. Review your rules and click Next, or
a. Click the Review rules that will be created button to open a window with more
information.
b. Click the Details button for more information, or click Close.
d. Select a target GPO for the rule and specify the GPO policy type. By default, the Administrators
group (stored within the BUILTIN\Administrators Active Directory OU) will be added to the rule.
Click Create to save the rule.
6. Once a discovered privileged application has been processed and a rule has been created for it or it has
been marked as ignored, the application is considered processed.
7. To view ignored applications or applications for which the rules were created, change the Process Date
of Item filter on the Applied Filters Wizard from "None: Item has not been processed" to the
corresponding Date Range.
8. The rule created from the application will be added to the selected GPO with a default name.
9. Select Export to export the list of applications presented on the grid. The list will be saved as
an .xls file.

After the rule has been created:
1. The rule will be added to the target GPO of the Group Policy Settings section; and
2. The rule will apply after the GPO settings are updated on the client computer.
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9

Deploying rules
Using the Create GPO with Default Rules Wizard (Privilege Elevation Rules only)
Using the Group Policy Management Editor
Using the Create Rule Wizard
Managing rules
Testing rules
Privilege Manager for Windows can create Privilege Elevation Rules and Blacklist Rules. Privilege Elevation
rules are rules that raise the permissions level of the user for an application. Blacklist rules deny a user access
to an application, regardless of what their default domain user permissions allows.

You can create five types of rules with Privilege Manager for Windows:
l

By Path to the Executable: a file rule that applies to the path to an executable. For more information,
see Creating file rules on page 48.

l

By Folder Path: a folder path rule that applies to all processes run from a path. For more information,
see Creating folder path rules on page 50.

l

By ActiveX Rule: an ActiveX rule that applies to a specific URL. For more information, see Creating
ActiveX rules on page 51.

Available only in Privilege Manager Professional and Professional Evaluation editions:
l

By Path to Windows Installer: a rule that applies to the path to Windows Installer files and patches.
For more information, see Creating rules for Windows Installer files on page 55.

l

By Path to Script File: a rule that applies to the path to a script file. For more information, see
Creating rules for script files on page 56.

You can create a rule in one of the following ways:
l

Create a default rule using the Create GPO with Default Rules Wizard.

l

Create a new rule using the Group Policy Management Editor or the Create Rule Wizard.

l

Import a GPO rule other system administrators have uploaded to the Community Rules
Exchange server.
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Once you create a rule, you can:
l

Test the rule. For more information, see Testing rules on page 64.

l

Share your rule on the Community Rules Exchange server. For more information, see Sharing your rules
with the community on page 68.

l

Edit or delete the rule. For more information, see Managing rules on page 63.

l

Build a report to view the rule's settings, save them into a file, and get statistics on the rule’s usage. For
more information, see Reporting on page 73.

Using the Create GPO with Default
Rules Wizard (Privilege Elevation
Rules only)
Privilege Manager for Windows contains a range of useful default rules that you can add to a new or existing
GPO. To create the default rules provided by Privilege Manager, use the Create GPO with Default Rules
Wizard. To access the wizard from the Getting Started screen, select the Setup Tasks tab and then doubleclick Create GPO with default rules.
NOTE:Rules created with this process are Privilege Elevation rules only. Blacklist rules cannot be
created here.

To use the Create GPO with Default Rules Wizard:
1. Double-click Create GPO with default rules to open the wizard.
2. Read the text in the Introduction dialog and click Next.
3. In the Select privilege elevation rules dialog, select your operating system from the drop-down menu
and select the corresponding rules from a list of common ones. Click Next.
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4. In the Select target GPO dialog, select or create a GPO to assign the rule to:
a. Select a GPO from the list under the domain that your local computer is a part of, or
b. Select a domain, click the Create GPO button, name it, and click OK. The newly created GPO will
be added to the All GPOs list in the Group Policy Objects container, or
c. Link any GPO not marked with the

icon to your domain or Active Directory OU.

i. Highlight the GPO in the left pane and click the Link GPO button on the right to link the
GPO to the domain or an OU.
ii. Browse for an OU or add the GPO to the domain in the dialog that displays.
iii. Click OK.
iv. Once the rule is created, its icon will change to
to indicate that it contains a rule and it
will be listed in the GPOs with Policy Settings node.
Note: You can only link a GPO to an item for which you have sufficient rights. For more
information, see Select user policy or computer policy.
d. Click Finish to save and apply the rule. If you have not specified the required data, the wizard will
notify you.
5. An error message will notify you if you have insufficient permissions to perform any of the operations
listed above.
a. You must have permission to perform the same actions in the GPMC.
b. Contact your system administrator to get the proper permissions.
6. The rule will display in the list of rules for the corresponding GPO under the Group Policy
Settings section.

7. The rule will apply once the Group Policy is updated on the client computer.
8. A message will notify you that the rule’s parameters will change once the trial period expires, if you
create a rule with any of the Privilege Manager Professional features while using the evaluation edition.
For more information, see Editions on page 7.
9. Modify the rule, as necessary. For more information, see Managing rules on page 63.
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Using the Group Policy Management
Editor
The Group Policy Management Console (GPMC) is a built-in Microsoft Management Console (MMC) snap in.
You can use the features in Privilege Manager based on your Windows rights within the GPMC.
You can use the Group Policy Management Editor in the GPMC to manage and create rules or you can use the
Create Rule Wizard in the Privilege Manager for Windows console.

To use the Group Policy Management Editor to create and manage rules:
1. Open the MMC. On the Start menu, click Run, type MMC, and then click OK.
2. From the File menu, select Add/Remove Snap-in. The Add or Remove Snap-ins dialog box will open.
a. Select Group Policy Management under the list of snap-ins.
b. Click the Add button.
c. Click OK.
3. The Console Root window now has a snap-in, Group Policy Management, rooted at the Console
Root folder.
4. Right-click a GPO under your forest in the Group Policy Management pane on the right and select Edit.
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5. The Group Policy Management Editor will open. The editor now has Privilege Manager for Windows
nodes, under Computer Configuration and User Configuration.

a. The right pane has an Extended and a Standard tab.
b. Click the Extended tab for more information about an item.
6. Available only in Privilege Manager Professional and Professional Evaluation editions. To create new
rule, select a Privilege Manager for Windows node and use the
toolbar buttons to delete or modify it. Before clicking the
Privilege Elevation Rules or Blacklist Rules tab.

New Rule button, or use the other

New Rule button, be sure to select the
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Using the Create Rule Wizard
To use the Create Rule Wizard:
1. Select or create a GPO in the All GPOs node in the left pane of the Privilege Manager for
Windows console:
a. Select a GPO from the list under the domain that your local computer is a part of, or
b. Select a domain, click the
New GPO button, name it, and click OK. The newly created GPO
will be added to the All GPOs list in the Group Policy Objects container.
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2. Link any GPO not marked with the

icon to your domain or Active Directory OU.

a. Highlight the GPO in the left pane and click the

Link button above it.

b. Browse for an OU or add the GPO to the domain in the dialog that displays.
c. Click OK.
d. Once the rule is created, its icon will change to
listed in the GPOs with Policy Settings node.

to indicate that it contains a rule and it will be

Note: You can only link a GPO to an item for which you have sufficient rights. For more
information, see Select user policy or computer policy.
3. Use the Create Rule Wizard to configure the rule.
a. Select the Privilege Elevation Rules or Blacklist Rules tab based on the type of rule
to be created.
b. Click the

New Rule button to open the Create Rule Wizard.

c. Specify the data requested in each tab and click Next.
i. When creating a Privilege Elevation rule follow the prompts through the default tabs: Start,
Description, Type, Groups, and Validation Logic (available only for Privilege Manager
Professional). The Privileges and Integrity tabs display as advanced options.
When creating a Blacklist rule follow the prompts through the default tabs: Start,
Description, Type, and Validation Logic (available only for Privilege Manager
Professsional).
ii. Enter the required fields, marked * on the Description and Type tabs.
d. Click Finish to save and apply the rule. If you have not specified the required data, the wizard will
notify you.
4. Click the
Save button on the menu bar of the Rule section. Or, if asked, confirm that you want to
save the rule.
5. An error message will notify you if you have insufficient permissions to perform any of the operations
listed above.
a. You must have permission to perform the same actions in the GPMC.
b. Contact your system administrator to get the proper permissions.
6. The rule will apply once the Group Policy is updated on the client computer.
7. A message will notify you that the rule’s parameters will change once the trial period expires, if you
create a rule with any of the Privilege Manager Professional features while using the evaluation edition.
For more information, see Editions on page 7.
You can also use GPO rules other system administrators have uploaded to the Community Rules Exchange
server. For more information, see Applying community rules to your domain/GPO on page 65.
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Getting started
To use the Start tab in the Create Rule Wizard:
1. Select Create your own rule to create your own settings, or
2. Create a rule with pre-defined settings:
a. Select the Select common rule from the list below option.
b. Use the Operating System menu to sort the rules according to the operating system
they apply to.
c. Click Next to modify the default settings, or click Finish to save the your settings for the target
GPO and quit.

To use the Description tab in the Create Rule Wizard:
1. Enter a title to identify the rule and an optional description.
2. To share your rule with the community, check the On completion, open a dialog to share this rule with
the community checkbox (Privilege Elevation Rules only).
a. Register on the Privilege Manager Community Forum dialog that will display. For more
information, see Joining the community on page 67.
b. Share the rule later, after you have tested it. For more information, see Sharing your rules with the
community on page 68.
3. Available only in Privilege Manager Professional and Professional Evaluation editions.
a. Check the Advertise this rule in the system tray on client computers option to display the title
of the rule when using the View current rules option on the client system tray.
The system tray also pop ups a desktop notification message any time there is a change to the set
of rules flagged as advertised.
b. Check the Disable the rule regardless of validation option to stop the rule from applying until
you uncheck the option.
4. Click Next.

To use the Type Tab in the Create Rule Wizard to specify the essential parameters of the
processes for the rule:
1. Select the type of rule that you would like to create.
l

By Path to the Executable: a file rule that applies to the path to an executable. For more
information, see Creating file rules on page 48.

l

By Folder Path: a folder path rule that applies to all processes run from a path. For more
information, see Creating folder path rules on page 50.

l

By ActiveX Rule: an ActiveX rule that applies to a specific URL. For more information, see
Creating ActiveX rules on page 51.

Available only in Privilege Manager Professional and Professional Evaluation editions:
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l

By Path to Windows Installer: a rule that applies to the path to Windows Installer files and
patches. For more information, see Creating rules for Windows Installer files on page 55.

l

By Path to Script File: a rule that applies to the path to a script file. For more information, see
Creating rules for script files on page 56.

2. Specify the options that correspond to the type of rule you have selected.
3. Select user policy or computer policy.
Define whether the rule will be user or computer-based.
l

User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l

Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

Creating file rules
Use the By Path to the Executable rule to elevate or decrease privileges for processes that start from an
executable file.

To create a By Path to the Executable file rule using the Create Rule Wizard:
1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 45.
2. Specify the Path to an executable file on the client computer or a network share in one of the
following ways:
l

Type the path to the file, including its extension, in the following format:
\\ComputerName\SharedFolder\Filename.exe
DriveLetter:\Filename.exe

l

Use the common % variable and the * and ? wildcards to identify the path, for example,
*\filename.exe.

l

Use the Browse
prompt you to:

button to locate the path. Once you locate the process, a dialog will

a. Retrieve a digital signature for the rule's Publisher field. Click Yes to add the available
digital signature. Click No to skip the prompt.
b. Create a file version for the file. Click Yes to add the setting. Click No to skip the prompt.
c. Create a unique cryptographic hash for the file to secure its identification. Click Yes to add
the setting. Click No if you are creating the rule for the file for which data is likely to be
updated in the future, or for any file with its name within the specified folder.
Note: When saving the rule, Privilege Manager for Windows converts the path into
environment variables.
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3. Click the Processes button to simplify adding parameters into the rule. Available only in Privilege
Manager Professional and Professional Evaluation editions.
a. Select whether you will create the rule from a process on a local or remote computer.
b. A list of processes running on the computer will open. Locate the process and view its details in
the fields to the right:
l

Path: the path to the process's executable.

l

Arguments: the arguments with which the process was started.

l

Publisher: the digital certificate of a publisher.

l

Version: the File Version property.

l

Hash: a unique cryptographic hash.

l

Integrity level: the security level with which the process runs in Windows 7 and higher.

l

Privileges: the privileges granted to the process.

c. Click OK. The data for the processes will be saved to the rule and displayed on the
corresponding tabs of the wizard.
d. To troubleshoot a Failed to retrieve processes. Please refer to documentation for more info
error, check the following on the remote computer:
i. The computer is turned on and accessible from the network;
ii. The domain administrator credentials have been provided; and
iii. Windows Management Instrumentation (WMI), Distributed Component Object Model
(DCOM), File and Printer Sharing, and Remote Administration are allowed through
the firewall.
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4. Fill in these optional fields, as necessary:
l

Arguments: Specify the common or user-defined arguments with which the executable will run.
For example, to build a rule that will allow a non-administrator to access the Date/Time tool in the
Control Panel from the task bar, enter this data:
i. Path: %SystemFolder%\rundll32.exe
ii. Arguments: /d c:\windows\system32\shell32.dll,Control_RunDLL
timedate.cpl

l

Available only in Privilege Manager Professional and Professional Evaluation editions.
l

Publisher: Limit elevation to files signed with the digital certificate of a publisher. Enter the
exact name or use the Browse

l

l

button to locate it.

File Version: Limit elevation to those whose File Version property match the
ones specified.

File Hash: Click the Browse
button to locate the file and create a unique cryptographic hash
that limits elevation to files that match it. This ensures that the rule will not apply to dangerous
content that is similarly named and will help prevent security issues.
NOTE: The file hash will not apply to a file that you have modified during program
updates, so do not add it to the rule for a file which is likely to be updated, or for any file
with the same name in that location.

l

Apply settings to child processes: Ensure that child processes triggered by the rule will not fail
due to lack of privileges. This checkbox is enabled by default.

l

User’s context will be used to resolve system and resource access: Ensure that the client will
use the target's user environment to resolve file and registry access. This might be required to
resolve drive mappings, and also if the rule specifies the publisher, version, or file hash for the
target process running from a network location.

5. Define whether the rule will be user or computer-based.
l

User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l

Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

6. Complete the Privileges (see Granting/denying privileges (Privilege Elevation Rules only)) and Integrity
(see Differentiating security levels (Privilege Elevation Rules only)) tabs to modify the rule.
7. Click Finish to quit the wizard.
8. The rule will be named after the executable.

Creating folder path rules
Use the By Folder Path rule to elevate or decrease privileges for processes that start from a folder path.
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To create a By Folder Path rule using the Create Rule Wizard:
1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 45.
2. Specify the location of a Folder on the client computer or a network share in one of the following ways:
l

Type the folder path in the following format:
\\ComputerName\SharedFolder
DriveLetter:\Folder

l

Use the common % variable and the * and ? wildcards to identify the folder, for
example, *\Folder

l

Use the Browse

button to locate the folder.

Note: When saving the rule, Privilege Manager for Windows converts the path into
environment variables.
3. Fill in these optional fields, as necessary:
l

Available only in Privilege Manager Professional and Professional Evaluation editions.
Publisher: Limit elevation to files signed with the digital certificate of a publisher. Enter the exact
name or use the Browse

button to locate it.

l

Apply settings to sub folders: Apply the rule to processes started from any file under any sub
folders of the path.

l

Apply settings to child processes: Ensure that child processes triggered by the rule will not fail
due to lack of privileges. This checkbox is enabled by default.

l

User’s context will be used to resolve system and resource access: Ensure that the client will
use the target's user environment to resolve file and registry access. This might be required to
resolve drive mappings, and also if the rule specifies the publisher, version, or file hash for the
target process running from a network location.

4. Define whether the rule will be user or computer-based.
l

User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l

Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

5. Complete the Privileges (see Granting/denying privileges (Privilege Elevation Rules only)) and Integrity
(see Differentiating security levels (Privilege Elevation Rules only)) tabs to modify the rule.
6. Click Finish to quit the wizard.
7. The rule will be named after the folder path.

Creating ActiveX rules
Use the By ActiveX Rule to allow installation of ActiveX controls from the Internet.
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To create an ActiveX Rule using the Create Rule Wizard:
1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 45.
2. Specify the URL for the ActiveX control in the Source URL field, for example:
http://*.macromedia.com*
3. Available only in Privilege Manager Professional and Professional Evaluation editions.
a. Click the Installed ActiveX Controls button to view details of the ActiveX controls installed on the
local computer and create rules based on them.
b. Fill in these optional fields, as necessary.
l

Control: Enter the name of the ActiveX control from the CodeBase attribute of
the web page.

l

CLSID/MIME: Restrict loading a control unless the CLSID or MIME value on the web page
matches the one specified.

l

ActiveX Version: Restrict elevation to ActiveX controls with a matching version number
on the web page from which it will be downloaded.

4. Define whether the rule will be user or computer-based.
l

User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l

Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

5. Click Finish to quit the wizard.
6. The rule will be named after the ActiveX control.
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Applying ActiveX rules
In order for an ActiveX rule to take effect on clients, set up the following components:
1. Enable Quest's GPE ActiveX Installer add-on in the Internet Explorer browser.

2. Open the Internet Options menu.
a. Uncheck the Enable Protected Mode checkbox on the Security tab.
b. Check the Enable third-party browser extensions* checkbox on the Advanced tab.
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3. Restart Internet Explorer.
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To centrally enable third-party browser extensions by modifying a GPO:
1. Create a dedicated GPO or open the Group Policy Management Editor.
2. Go to Computer Configuration > Administrative Templates: Policy definitions (ADMX files) >
Windows Components > Internet Explorer > Internet Control Panel > Advanced Page, and doubleclick on Allow third-party browser extensions in the list to the right and enable it.

3. Open the User Configuration node and perform the configurations described in step 2 above.

Creating rules for Windows Installer files
Available only in Privilege Manager Professional and Professional Evaluation editions.
Use the By Path to Windows Installer rule to elevate or decrease privileges for processes that start from
Windows Installer files (.msi) and patches (.msp).
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To create a By Path to Windows Installer rule using the Create Rule Wizard:
1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 45.
2. Fill in the following fields:
l

Name: Set a path to an .msi or .msp file. Wildcards are supported and you can use the Browse
button to locate the path.

Optional:
l

Publisher: Limit elevation to files signed with the digital certificate of a publisher. Enter the exact
name or use the Browse

l

button to locate it.

Product Code: Limit elevation to those whose ProductCode MSI property match the one
specified. Enter the exact name or use the Browse

button to locate it.

l

Product Version: Limit elevation to those whose ProductVersion MSI property match the
one specified.

l

File Hash: Click the Browse
button to locate the file and create a unique cryptographic hash
that limits elevation to files that match it. This ensures that the rule will not apply to dangerous
content that is similarly named and will help prevent security issues.

l

Apply settings to child processes: Ensure that child processes triggered by the rule will not fail
due to lack of privileges. This checkbox is enabled by default.

l

User’s context will be used to resolve system and resource access: Ensure that the client will
use the target's user environment to resolve file and registry access. This might be required to
resolve drive mappings, and also if the rule specifies the publisher, version, or file hash for the
target process running from a network location.

3. Define whether the rule will be user or computer-based.
l

User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l

Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

4. Complete the Privileges (see Granting/denying privileges (Privilege Elevation Rules only)) and Integrity
(see Differentiating security levels (Privilege Elevation Rules only)) tabs to modify the rule.
5. Click Finish to quit the wizard.
6. The rule will be named after the installer file or patch.

Creating rules for script files
Available only in Privilege Manager Professional and Professional Evaluation editions.
Use the By Path to Script File rule to elevate or decrease privileges for processes that start from a script file.
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To create a By Path to Script File rule using the Create Rule Wizard:
1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 45.
2. Set the absolute or relative path to one of the following types of script files:
l

Command Prompt: .cmd

l

Batch File: .bat

l

JavaScript: .js

l

VBScript: .vbs

l

PowerShell: .ps1

l

Perl: .pl

Wildcards are supported and you can use the Browse

button to locate the path.

3. Fill in these optional fields, as necessary:
l

Publisher: Limit elevation to files signed with the digital certificate of a publisher. Enter the exact
name or use the Browse

button to locate it.

This field is not supported for .pl, .cmd, and .bat files.
l

File Hash: Click the Browse
button to locate the file and create a unique cryptographic hash
that limits elevation to files that match it. This ensures that the rule will not apply to dangerous
content that is similarly named and will help prevent security issues.

l

Apply settings to child processes: Ensure that child processes triggered by the rule will not fail
due to lack of privileges. This checkbox is enabled by default.

l

User’s context will be used to resolve system and resource access: Ensure that the client will
use the target's user environment to resolve file and registry access. This might be required to
resolve drive mappings, and also if the rule specifies the publisher, version, or file hash for the
target process running from a network location.

4. Define whether the rule will be user or computer-based.
l

User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l

Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

5. Complete the Privileges (see Granting/denying privileges (Privilege Elevation Rules only)) and Integrity
(see Differentiating security levels (Privilege Elevation Rules only)) tabs to modify the rule.
6. Click Finish to quit the wizard.
7. The rule will be named after the script file.
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Using Active Directory user groups (Privilege
Elevation Rules only)
Use the Groups tab to add or remove an Active Directory user group from the security token of the target
process. Removing a group decreases the privileges with which the process will run.

To add or remove an Active Directory user group using the Groups tab in the Create
Rule Wizard:
1. If the Administrators group (stored within the BUILTIN\Administrators Active Directory OU) does not
appear on the list by default, click the

button to add it.

l

Select this group of users, who have complete and unrestricted access to a local computer,
instead of domain administrators.

l

The

2. Use the

button will not be active if the group is already on the list.
button to add or remove other groups. When the window opens:

a. Use the Browse button to specify the group name.
b. Select add or remove.
3. To delete or modify a record within the Security Group list, select it and use the

or

button.

l

You can only add security groups in Active Directory which have a group scope property
of Built-in local to the security token of a process on a client computer if the client also has
the same security identifier definition (SID) in its built-in security groups.

l

When removing a group from the security token, ensure that the user account under
which the process is launched is a member of more than one primary group. Otherwise,
the rule will not apply as intended.

Using validation logic
Available only in Privilege Manager Professional and Professional Evaluation editions.
By default, a rule will apply to all client computers to which the previously selected GPO is linked. For more
granular targeting, you can use the Standard Rules and Validation Logic Rules sub-tabs of the Validation Logic
tab in the Create Rule Wizard to target the rule based on the client’s operating system, their IP address, and/or a
logged-in user.

Using standard rules
Within the Standard Rules sub-tab in the Create Rule Wizard, you can set a rule to apply only to clients with
specified operating systems, servers, or workstations. By default, all operating systems are selected. If no
options are selected, then the rule will apply to all supported operating systems.

Privilege Manager for Windows 4.1 Administrator Guide
Deploying rules

58

To use the Standard Rules sub-tab in the Create Rule Wizard:
l

Check the Server checkbox in the Class section to apply the rule to Windows Server 2008/2008
R2/2012/2012 R2.

l

Check the Workstation checkbox in the Class section to apply the rule to Windows 7/8.1/10.

l

In the Operating System section, check the checkboxes for your operating systems.

Using validation logic rules
The Validation Logic Rules sub-tab in the Create Rule Wizard allows you to set additional parameters to target
the rule. You can define whether the rule will run on computers with a prefix in the name, a group or IP address
range, or a user currently logged in. For example, you can target the rule to computers belonging to OUs that
end with DEPARTMENT and are in subnet 192.168.0.X, except for the IP address 192.168.0.1.
Note: Client Deployment Settings can only be targeted to specific computers and not to user accounts or
groups.

Setting rule parameters
To set rule parameters using the Validation Logic Rules sub-tab in the Create Rule Wizard:
1. Click Add to open the Add Validation Logic Rule window.
2. Select the type of rule:
Type of Rule

Action
Set a rule for one or several names, or partial names, of your Active Directory
computer groups. Enter the NetBIOS name, for example:

Computer Group

User Group

DERPA\DOMAIN CONTROLLERS
Set a rule for one or several names, or partial names, of your Active Directory user
groups. The group membership value you enter will be compared against the
groups that the user belongs to during the logon process and must match for the
configuration to be processed. Enter the NetBIOS name, for example:
DERPA\ADMINISTRATORS
Set a rule if specific users are logged into client computers. Enter the NetBIOS
name, for example:

User Name

OU (Computer)

DERPA\HELPDESK
Set a rule for names, or partial names, of computer-based OUs or the Computers
container in your Active Directory. The OU value you enter will be compared
against the OU the client computer belongs to during the logon process and must
match for the configuration to be processed. Enter the fully qualified domain name
(FQDN), for example:
DERPA.DERPADEV.LOCAL\DOMAIN CONTROLLERS
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Type of Rule

OU (User)

Action
l

To select OUs, check the OU checkboxes.

l

To select all containers (instead of OUs), select the domain so that it is
highlighted.

l

To include child objects, highlight the parent object and check Include
child objects.

Set a rule for names, or partial names, of the user-based OUs or the Users
container in your Active Directory. The OU value you enter will be compared
against the OU the user belongs to during the logon process and must match for
the configuration to be processed. Enter the FQDN, for example:
DERPA.DERPADEV.LOCAL\USER ACCOUNTS
l

To select OUs, check the OU checkboxes.

l

To select all containers (instead of OUs), select the domain so that it is
highlighted.

l

To include child objects, highlight the parent object and check Include
child objects.

Set a rule for computers with names or partial names. Enter the FQDN, for
example:
Computer Name

DERPA.DERPADEV.LOCAL\PASERVER
Set a rule for IP addresses or ranges of computers.

IP Address Range
(v4/v6)
Set a rule based on the registry keys on client computers.

Registry Key Exists
Set a rule for files on the client computer or on the network. Specify a file that must
exist on the client computer or on the network in order for the rule to run, for
example:
File Exists

\\ComputerName\SharedFolder\Filename.exe
DriveLetter:\Filename.exe
Note: On the Type tab of the Create Rule Wizard, check the checkbox for
User’s context will be used to resolve system and resource access to
ensure that the rule will apply.
Define when a rule should start and/or stop being enforced.
a. Check the checkboxes before the date and/or time fields in the Date
Range/Time Range sections.
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Type of Rule

Action

Date and Time Range

b. Set the values.
c. The rule will apply according to the time/date parameters of the console
used to create the rule.

3. Specify the rule's parameters in the dialog window that will display on the right:

l

Use the common asterisk (*) and question mark (?) wildcards in the validation value, as necessary.
l

* : Stands for no or any number of any characters

l

? : Stands for a single character

l

Check the NOT checkbox to exclude the items specified from the rule.

l

For

Computer Group,

(User), and

User Group,

User Name,

OU (Computer),

OU

Computer Name:

a. Use the Name field to specify the rule's value manually (see example values in the table above),
and then click the

button. Or,

b. Use the
Browse button to select the items available on your network. You can filter the items
by the first letters. Wildcards are not supported in the Filter field.
c. The desired value will be added to the list. You may add as many rule values as necessary.
4. Click OK when you are finished specifying the settings within the rule type. The record will display in the
main Validation Logic Rules list.
5. To add another validation logic rule, repeat the steps above.
6. Add or combine validation logic rules with AND or OR Boolean logic. By default, rules will combine with
OR Boolean logic. To make the rule use the AND operator, select AND at the bottom of the Validation
Logic Rules window.
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7. To edit a rule setting:
a. Within the Validation Logic Rules list, double-click a rule value or click the Edit button.
b. Make changes in the dialog.
8. When finished specifying validation logic rules, click Next. If the Display Advanced Options checkbox
has not been selected, complete the rule creation process.

Granting/denying privileges (Privilege Elevation
Rules only)
On the Privileges tab in the Create Rule Wizard you can grant or deny privileges for a process, based on the
standard Windows policies in the User Rights Assignment list (Local Security Settings\Local Policies).

To apply/deny privileges for processes (including child processes) using the Privileges tab in the
Create Rule Wizard:
1. Select the privilege and click Grant or Deny. To select multiple privileges, hold down the CTRL (or
SHIFT) key while selecting the items.
2. To discard your choices, select the privilege and click Not Set.

Differentiating security levels (Privilege
Elevation Rules only)
You can differentiate the security levels with which a process will run using the Integrity tab in the Create Rule
Wizard. The integrity level is a feature of Windows operating systems beginning with Windows 7.
This parameter can be applied to clients running Windows Server 2008, Windows 7 and Windows Server 2008
R2 and Windows Server 2012, and Windows 8.1 and Windows Server 2012 R2, and Windows 10.
By default, this setting will not apply and is set to the High integrity level.
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Managing rules
Once a rule is created, you can change its settings, delete it, or upload it to the Community Rules Exchange
server (Privilege Elevation Rules only).

To delete, modify, or share a rule, use the toolbar buttons:

To use the Edit Rule Wizard to configure a rule:
1. Select the Privilege Elevation Rules or Blacklist Rules tab based on the type of rule to be created.
2. Double-click a rule's title or click the Details button on the toolbar to open the Edit Rule Wizard.
3. Specify the data requested in each tab and click Next.
a. Follow the prompts through the default tabs: Description, Type, Groups, and Validation Logic
(available only for Privilege Manager Professional). The Privileges and Integrity tabs display as
advanced options.
b. Enter the required fields, marked * on the Description and Type tabs.
4. Click Finish to save and apply the rule. If you have not specified the required data, the wizard
will notify you.
5. Click the
Save button on the menu bar of the Rule section. Or, if asked, confirm that you want to
save the rule.

More information for managing rules:
l

To delete or modify a GPO created with Privilege Manager, use the Microsoft Group Policy Management
Console (GPMC). You can also edit rules using the GPMC. For more information, see Using the Group
Policy Management Editor on page 43.

l

If you are using the Privilege Manager Community Edition and open a rule with a Privilege Manager
Professional feature to view or modify its settings, a notification will display. Click Yes to open the Edit
Rule window to display all the rule settings except for the Professional ones. Modifying the rule will
discard the Professional features.

l

To share a rule with the community, see Sharing your rules with the community on page 68.
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Testing rules
You can test a rule to ensure that the settings you specified map to a process on a local or remote computer.
You can test all types of rules, except ActiveX.

Before you test a rule, ensure the following components are set up:
1. The client is running on the computer on which you intend to test the rule.
2. The remote computer is switched on and is accessible from the network.
3. The correct credentials to connect to the remote computer are provided.
4. The following exceptions are added for remote computers with a firewall turned on:
l

Windows Management Instrumentation (WMI): dllhost.exe

l

Host process for Windows services: svchost.exe for 32-bit OS and
%SystemRoot%\SysWOW64\svchost.exe for 64-bit OS.

To test a rule:
1. Within the Group Policy Settings section, select a rule, and click the

Test button.

2. Select whether to test the rule on a local or remote computer.
3. A test window will open and the test will start. The window will display the initial conditions necessary for
the rule to run and present its status in the Test Progress section, testing if:
l

The connection with the target computer has been established;

l

The client is installed on your computer;

l

The Group Policy update has run successfully on the client computer;

l

The GPO with the selected rule is present on the domain; and

l

The rule exists on the client side and on the domain.

4. If the test fails any of the steps, resolve the issue. If you encounter a Failed to retrieve processes.
Please refer to documentation for more info error, complete the steps above before you test the rule.
5. Click Next.
6. When the Detecting Process window opens, manually run the process the rule will apply to. Use
the parameters specified in the Rule Details section of the Test File Rule window. The window will
show two tabs:
l

l

The Started Processes tab with the processes started after you switched from the Detecting
Process window.
l

The process that you’ve started to test the rule will display with either a tick or
a cross sign.

l

If the process is marked with the cross sign, look at the Process Details and check that
you started the process with the right parameters, or modify the rule settings. And,

The All Processes tab with all currently running processes.

7. Once the rule is created and distributed to clients via Group Policy, the rule will be applied to the
corresponding process.
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10

Community rules exchange
Viewing rules configured by others
Applying community rules to your domain/GPO
Joining the community
Sharing your rules with the community
Managing community rules
Use the Community screens to view rules customers have shared and import them to your network. Visit the
community online: https://www.quest.com/community/products/dams and read on for more information, as well
as instructions on uploading your own rules to the database to share.

Viewing rules configured by others
To view Community rules other customers have shared:
1. Open the console.
2. Click All Rules under the Community section.
3. The list of rules will display if the console connects to the Rules Exchange server over the Internet.

Applying community rules to your
domain/GPO
To use a Community rule and learn how GPO settings have been configured by other customers, run the Import
Rule Wizard.
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Using the Import Rule Wizard
To use the Import Rule Wizard to import a Community rule:
1. Within the All Rules or Verified Rules section of the Community node on the console, select a rule, and
click the

Import icon. A dialog with the rule settings will open.

2. If you are using the Privilege Manager Community Edition and try to import a rule with a Privilege
Manager Professional feature, a notification will display. Click Yes to open the Import Rule Wizard to
display all the rule settings except for the Professional ones.
3. Switch between the tabs of the dialog to view the GPO settings or modify the rule. For more information,
see Using the Create GPO with Default Rules Wizard (Privilege Elevation Rules only) on page 41.
4. Click the GPO tab to assign the rule to an existing GPO, or use the New GPO button to create one. For
more information, see Using the Create Rule Wizard on page 45.
5. Click Finish to add the rule to your domain’s GPO settings.
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6. The rule will display in the list of rules for the corresponding GPO under the Group Policy
Settings section.

7. The rule will apply once the Group Policy is updated on the client computer.
8. Modify the rule, as necessary. For more information, see Managing rules on page 63.

Joining the community
To upload your rules to the Community Rules Exchange Server, view My Shared Rules content, or comment on
a Community rule, you first have to be authorized by the server.

To Sign-In or Register for the Privilege Manager for Windows Community Forum:
1. Open the console.
2. Click My Shared Rules under the Community section.
3. If you are already registered, enter your email and password in the Login tab and click Login.
4. If you have not yet registered:
a. Consider specifying your proxy server settings in the console before you register to prevent
Internet connection problems.
b. Click on the Register on the web link on the Login tab. You will be directed to the registration
page. Or, use the Register tab. Fill in every field of the form. Your password must contain at least
7 characters.

To log into the server as a different user:
l

Click Getting Started > Additional Resources > Logout of Rules Exchange. You’ll be asked for login
credentials.
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Sharing your rules with the community
To share rules that other customers might find useful:
NOTE:Only Privilege Elevation Rules can be shared with the community.
1. Within the Group Policy Settings node, right-click the rule to share, and select Share with Rules
Exchange on the shortcut menu, or click the Share button on the toolbar.
2. Within the window that opens, modify the GPO rule settings, and click OK.
3. If you have not registered for the Privilege Manager Community Forum, you will be prompted to do so.
For more information, see Joining the community on page 67.
4. Once you have registered, the rule will be displayed under the Community node in the All Rules section
as well as in the My Shared Rules section.

Managing community rules
To delete a rule that you’ve shared from the Community > All Rules list:
1. Go to the My Shared Rules section and select the rule.
2. Click the

Delete button.

3. The rule will be deleted after the operation is confirmed.

To modify the settings of a rule you’ve shared:
1. Use the Group Policy Settings node to make the necessary changes. For more information, see
Managing rules on page 63.
2. Upload the modified rule to the Community Rules Exchange Server (see Sharing your rules with the
community on page 68). The rule’s information will be updated automatically.
3. Within the Community node, you can modify a rule's title and description.
a. Within the My Shared Rules section, select a rule.
b. Use the

icon to modify the information.

To rate rules uploaded to the Community Rules Exchange Server:
1. Within any section of the Community node, right-click the rule, and choose between Not set,
Poor,
Fair,
Rating sub-menu.

Good,

Very Good, or

Excellent in the My

2. Your rating will be saved and the average total will display in the Rating column of the grid.

To comment on rules uploaded to the Community Rules Exchange Server:
1. Within any section of the Community node, double-click a rule.
2. Use Add Comment button to submit your comment.
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Registration at the Community Rules Exchange is required (see Joining the community on page 67).
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Removing local admin rights
Using the Active Directory Users and Computers utility
Using the Users with Local Admin Rights screen
The last step in preparing your environment for least privileged use is to remove administrative access from
users who no longer require it.

Using the Active Directory Users and
Computers utility
Use the Windows utility Active Directory Users and Computers, installed on Windows Server operating
systems such as Windows 2008, to scrub the Domain Administrators group of users that should no longer be
given administrative rights to every computer in the domain. Select Domain Admins Properties > Members
tab > Remove.
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Using the Users with Local Admin
Rights screen
Available only in Privilege Manager Professional and Professional Evaluation editions.
Under the Discovery & Remediation tab on the console, select the Users with Local Admin Rights screen to
discover which domain users have been assigned to the local Administrators group on client computers and
remove them.

Before you begin, check the following on each target computer:
1. The computer is turned on and accessible from the network; and
2. Windows Management Instrumentation (WMI), Distributed Component Object Model (DCOM), File and
Printer Sharing, and Remote Administration are allowed through the firewall.
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To remove domain users from the local Administrators group on computers on your domain:
1. Within the Select Computers section, use the Add and Remove buttons to add and remove computers.
l

You cannot select a domain controller computer.

l

If the File and Printer Sharing exception is not enabled for a computer, it will not display in the list.

l

If the Windows Management Instrumentation exception is not enabled, the Class and OS
columns will display the Unavailable value.

2. Click the Clear all entries button to remove all computers from the list.
3. Click the Discover Accounts in local Administrator groups button to discover domain users and
groups with local administrator rights.
4. In the window that opens, specify whether to search for local Administrator groups, users, or both.
5. A window will display your progress as the list builds.
a. If an error occurs, it will display in the Errors section with a description. The Unable to open log
file... notification signifies that no users in the local Administrators group have been detected.
b. Click the Open report file button to view data on detected users. The button will not be activated
if no users have been found in the local Administrators group.
c. When the discovery operation is completed, click the Close button.
6. The list of discovered users will display in the User Accounts Discovered in Local Administrators
Groups section.
7. Revise the list to only include users you are going to revoke rights from.
a. Click the Exclude selected entries from list link to remove users from this list and preserve their
local administrator rights.
b. Click the Remove all listed users from local Administrators groups button.
8. In the window that opens, click Yes to confirm that you want to remove the users or groups.
9. A window will display your progress as the users are removed.
a. If an error occurs, it will display in the Errors section with a description.
b. Click the Open report file button to view the operation log.
10. When the operation is complete, the users will no longer have local administrator rights.
Congratulations - You are now running in a least privileged use environment!
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Reporting
Elevation Activity Report
Blacklist Activity Report
Rule Deployment Report
Instant Elevation Report
Temporary Session Elevation Request Report
Temporary Session Elevation Usage Report
Rule Details Report
Advanced Policy Settings Report
Generating and using reports
Using the Applied Filters Wizard
Using the Scheduled Reports Details Wizard
Using the Resultant Set of Policy Wizard
Reporting is available only within the Professional edition; once a trial license expires, data will no longer be
collected and reports will stop generating.

You can build five types of reports on activities from client computers:
l

Blacklist Activity Report: lists how frequently a rule is used.

l

Rule Deployment Report: lists rules deployed on the client computer.

l

Instant Elevation Report: lists processes that have been elevated using instant elevation.

l

Rule Details Report: lists rules that have been configured.

l

Advanced Policy Settings Report: lists Advanced Policy Settings, except those set to the Not
Configured option.

In addition to these out of the box reports, you can create custom reports using third party tools to query the
SQL-based Privilege Manager for Windows reporting database. Use this database schema to create your own
custom reports or data analysis:
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A PAReporting database is created when you set up the server and is configured to work with the ScriptLogic
PA Reporting Service, the data collection web service running on a console host.

Before you generate reports, ensure the following components are set up:
1. The server is configured and you can successfully join the data collection web service running on it.
2. Client data collection settings are configured for the GPOs you will report on. You can generate reports
on GPOs for which you have read/write access in Windows.

Elevation Activity Report
This report allows you to track which rules were used to elevate processes during a period of time on
managed client computers. With this report, you can see when users have run privileged processes and on
which computers.
Each privilege elevation event reported contains these details:
l

Type: the privilege elevation rule type;

l

Elevated Item: the path to the elevated application or command with the argument (if any);
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l

Rule Name: the privilege elevation rule name;

l

Rule GUID: the privilege elevation rule globally unique identifier (GUID);

l

User (Domain\Name\OU): the user, domain name, and OU;

l

Computer (Domain\Name\OU\Class\OS): the computer, domain name, OU, class, and OS; and

l

Elevation Time: the time of the privilege elevation on the client computer.

To learn how to create this type of report and manage the data, see Generating and using reports.

Blacklist Activity Report
This report allows you to track which rules were used to blacklist processes during a period of time on managed
client computers. With this report, you can see when users have attempted to run blacklisted processes and on
which computers.
Each blacklist event reported contains these details:
l

Type: the privilege elevation rule type;

l

Blacklisted Item: the path to the blacklisted application or command with the argument (if any);

l

Rule Name: the privilege elevation rule name;

l

Rule GUID: the privilege elevation rule globally unique identifier (GUID);

l

User (Domain\Name\OU): the user, domain name, and OU;

l

Computer (Domain\Name\OU\Class\OS): the computer, domain name, OU, class, and OS; and

l

Blacklisted Time: the time of the blacklisted event on the client computer.

To learn how to create this type of report and manage the data, see Generating and using reports.

Rule Deployment Report
This report tracks the overall usage of privilege elevation rules across a domain. The report lists each rule,
showing how many clients it has been deployed to and how many times it has been used.
Each record about a deployed rule contains these details:
l

Rule Name: the privilege elevation rule name;

l

Rule GUID: the privilege elevation rule globally unique identifier (GUID);

l

For a Summary report:

l

l

# Comp: the number of client computers on which the rule is deployed;

l

# Used: the number of times the rule has been enforced;

For a Details report:
l

User (Domain\Name\OU): the user, domain name, and OU;

l

Computer (Domain\Name\OU\Class\OS): the computer, domain name, OU, class, and OS; and

l

Deployed Date: the date the rule was deployed on the client computer.

To learn how to create this type of report and manage the data, see Generating and using reports.
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Instant Elevation Report
This report allows you to track instant elevation activity during a period of time on managed client
computers. With this report, you can see when users have been granted instant elevation privileges and on
which computers.
Each privilege elevation event reported contains these details:
l

Type: the privilege elevation rule type;

l

Elevated Item: the path to the elevated application or command with the argument (if any);

l

Rule Name: the privilege elevation rule name;

l

Rule GUID: the privilege elevation rule globally unique identifier (GUID);

l

User (Domain\Name\OU): the user, domain name, and OU;

l

Computer (Domain\Name\OU\Class\OS): the computer, domain name, OU, class, and OS; and

l

Elevation Time: the time of the privilege elevation on the client computer.

To learn how to create this type of report and manage the data, see Generating and using reports.

Temporary Session Elevation Request
Report
This report allows you to track temporary session elevation passcode requests from managed client computers.
With this report, you can see when a passcode has been generated based on a request, if the request was
denied, or if the request is still pending review.
The Temporary Session Elevation Usage report contains these details:
l

User (Domain\Name) - The user that used the passcode on their machine.

l

Action - The state of the elevation request. This can be Pending (when a request is received), Granted
(when a passcode is generated for the request) or Denied ((when a passcode request was not granted).

l

Processed Date - The date the administrator responded to the request.

l

Reason - The reason given for the elevation request.

l

Maximum Allowed Usage -The number of times the passcode can be used before expiring.

l

Duration - The amount of time the passcode will remain active for when used.

l

Computer (Domain\Name) - The computer that the passcode quested from.

l

Request Sent - The date and time the user submitted the request for a passcode.

To learn how to create this type of report and manage the data, see Generating and using reports.
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Temporary Session Elevation Usage
Report
This report allows you to track temporary session elevation activity during a period of time on managed client
computers. With this report, you can see when users have been granted temporary instant elevation privileges
using passcodes, on which computers, and also which specific applications were elevated.
The Temporary Session Elevation Usage report contains these details:
l

User (Domain\Name) - The user that used the passcode on their machine.

l

Maximum Allowed Usage -The number of times the passcode can be used before expiring.

l

Remaining Usage - The number of times that are left to use this passcode.

l

Usage Count - The number of times this passcode has been used so far.

l

Elevated Item - The application that was run in an elevated state.

l

Computer (Domain\Name) - The computer that the passcode was used on.

l

Time Elevated - The date and time the elevation occurred.

l

Passcode ID - The exact passcode provided by the administrator.

To learn how to create this type of report and manage the data, see Generating and using reports.

Rule Details Report
This report lists all the configuration details for a rule in a single view. The detail for each privilege
elevation event are specified in the Create Rule Wizard. For more information, see Using the Create Rule
Wizard on page 45.
To learn how to create this type of report and manage the data, see Generating and using reports.

Advanced Policy Settings Report
This report lists all configuration details, except those set to the Not Configured option, of the Advanced Policy
Settings for your GPOs in a single view:
l

Client Data Collection Settings

l

Client Deployment Settings

l

Self-Service Elevation Request Settings

l

Privileged Application Discovery Settings

l

Instant Elevation Settings

The details for each privilege elevation event are specified in the corresponding section for each of the settings.
To learn how to create this type of report and manage the data, see Generating and using reports.
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Generating and using reports
To generate a report:
1. Under the Reporting section of the console, select the type of report. The window for the report will open
to the right.

2. Click the Generate Report button to generate a report based on the default filter settings displayed in
the Applied Filters section on the top of the screen. You can create multiple shared filter sets and
save settings that other administrators can use. For more information, see Using the Applied Filters
Wizard on page 79.
3. Use the
delete a filter.

toolbar next to the Applied Filters drop-down menu to add, edit, copy, or

4. The results will display below.
5. For the Rule Deployment report, use the Type and Sort menus to view additional information
and sort data.
6. Use the toolbar at the top of the results window to navigate the pages or organize them and
search for data.

7. To navigate across a multi–page report, use the

and

buttons.

8. The Number of Records field in the upper part of the results page refers to the number of rules listed in
the report.
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To save the data, use either the Copy or Export To buttons on the results window:
1. Click anywhere on the results window.
2. Click the Copy button.
3. Paste the copied data into a file.
Or,
1. In the toolbar of the of the results window, click the Export To PDF, Export To Excel, Export To Html, or
Export To RTF button to save the data into a PDF, Excel, HTML, or RTF file.
2. In the Save As window that will open, name the report.
3. Click Save.

Using the Applied Filters Wizard
To use the Applied Filters Wizard to modify displayed requests and save shared filters for other
administrators:
1. Open the console and select the area for your shared filter set.
a. Under the Reporting section, open the screen for Elevation Activity, Rule Deployment, Instant
Elevations, Rule Details, or Advanced Policy Settings, or
b. Under the Discovery and Remediation section, open the screen for Privileged Application
Discovery or Self-Service Elevation Requests.
2. The Applied Filters section will display on the top of the screen.

3. Use the
delete a filter.

toolbar next to the Applied Filters drop-down menu to add, edit, copy, or
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4. The Applied Filters Wizard will open when you add a filter.

a. Enter a name for your filter set.
b. Select a filter type in the left section.
c. Set the desired parameters in the right section.
d. Press Reset to reset to the default screen, OK to save your settings, or Cancel to
close the screen.
5. You can create multiple shared filter sets and save settings that other administrators can use.
6. Once you have selected a filter type, it is saved automatically and you can proceed to another
modification. Select as many filter types as necessary by switching between them and
configuring settings.
Note: Each filter type can have only one value specified. Every time you set a new value
for the same filter type, the newer one will overwrite the older one.
7. Click OK to save your changes when you are finished. The specified filter values will display in the
Applied Filters list.

Using the Scheduled Reports Details
Wizard
After you create a shared filter set to modify your report criteria, you can select a report and set its schedule and
delivery. You can configure it to go to multiple recipients, including you, your manager, and/or the help desk. In
addition, you can set the subject line to meet the requirements of your help desk. You can also specify network
and file share locations to send it to.
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To use the Scheduled Reports Details Wizard to generate a scheduled report:
1. Configure the server.
a. Use the Privilege Manager Server Setup Wizard to configure the Server Email Notification
Configuration settings on the first screen of the wizard.
b. If you have previously completed the wizard, the other screens will automatically populate.
c. Refer to the Privilege Manager for Windows Quick Start Guide for step-by-step instructions.
2. Create shared filter sets to modify your report criteria. You must create at least one shared filter set to
generate a scheduled report. Scheduled reports work only for shared filter sets configured in the
Reporting tab (except for the built-in Local Filters), not in Discovery & Remediation. For more
information, see Using the Applied Filters Wizard on page 79.
3. In the Reporting section of the navigation pane, select Scheduled Reports.
4. The Scheduled Reports section will display on the top of the screen.
a. Click the Refresh button to refresh the screen and update the last run time.
b. Use the

toolbar to add, edit, copy, or delete a report.

5. The Scheduled Reports Details Wizard will open when you add a report.
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6. Complete the Type tab and click Next.
7. Complete the Schedule tab.
a. Select the Start time.
b. Select the Cycle for how often the report will run. Changes to scheduled reports may take up to
10 minutes to take effect.
c. Click Next.
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8. Complete one of the sub-tabs under the Delivery tab.
a. Complete the Email sub-tab.
i. Use the

button to add email addresses and the

button to remove them.

ii. Enter a subject.
iii. Select the report format.
Or,
b. Complete the File share sub-tab.
i. Type the folder path in the following format: \\ComputerName\SharedFolder
ii. Use the Browse
iii. Use the

button to locate the folder.

button to add folder paths and the

button to remove them.

iv. Select the report format.
9. Click Finish.
10. After the report has been created, check your email or file share to confirm receipt.

Using the Resultant Set of Policy
Wizard
The Resultant Set of Policy (RSoP) Wizard is a built-in MMC snap in. It helps you view policy settings applied to
selected computers and users (in the logging mode) or simulate a policy implementation to plan changes to
your network (in the planning mode). On Windows 10 machines .Net 4.0 needs to be enabled or the PM
Console installed in order to view the values from the RSoP Wizard.

To use the Resultant Set of Policy Wizard to report on policies you have applied:
1. Install the client on the computer for which you are viewing or simulating a policy.
2. Open the MMC. On the Start menu, click Run, type MMC, and then click OK.
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3. From the File menu, select Add/Remove Snap-in. The Add or Remove Snap-ins dialog box will open.

a. Select Resultant Set of Policy under the list of snap-ins.
b. Click the Add button.
c. Click OK.
4. The Console Root window now has a snap-in, Resultant Set of Policy, rooted at the Console
Root folder.
5. Under the Name column, click Resultant Set of Policy.
6. Right-click Resultant Set of Policy and select Generate RSoP Data.
Or,
Under the Resultant Set of Policy pane in the Actions column, click More Actions and select
Generate RSoP Data.
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7. The Resultant Set of Policy Wizard will open.

a. Choose the Logging mode to review policy settings or the Planning mode to simulate a policy
implementation.
b. Specify the data requested in each tab and click Next.
c. Click Finish to quit the wizard.
8. The Console Root window now has Privilege Manager for Windows nodes, rooted at the Console Root
folder under Computer Configuration and User Configuration. Privilege Manager for Windows
Details will display on the right, showing the rules and advanced policy settings that were applied.
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Using Microsoft tools
You can use Microsoft tools with Privilege Manager for Windows to:
l

Install the client using the Group Policy Management Console. For more information, see Using the
Group Policy Management Console on page 14.

l

Create and manage rules using the Group Policy Management Editor in the Group Policy Management
Console. For more information, see Using the Group Policy Management Editor on page 43.

l

Remove local administrator rights using the Active Directory Users and Computers Utility. For more
information, see Using the Active Directory Users and Computers utility on page 70.

l

Report on policies you have applied using the Resultant Set of Policy Wizard. For more information, see
Using the Resultant Set of Policy Wizard on page 83.
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Maintaining a least privileged use
environment
Processing Self-Service Elevation Requests
Using Group Policy Settings
Maintain a least privileged use environment by processing self-service elevation requests, using the Console
Email Configuration screen, and using group policy settings.

Processing Self-Service Elevation
Requests
Monitor and process self-service requests from users using self-service notifications and the Self-Service
Elevation Requests screen under the Discovery & Remediation tab. You can approve or deny requests for
access to run privileged applications. If approved, an elevation rule will automatically be generated for each
request. For more information, see Using self-service notifications on page 30 and Using the Self-Service
Elevation Request Processing Wizard on page 30.

Using the Console Email Configuration screen
If you would like an email message to be sent to the user when you have approved or denied their self-service
elevation request, you can configure the settings using the Console Email Configuration screen found under
Setup Tasks. For more information, see Using the Console Email Configuration screen on page 32.

Using Group Policy Settings
Use the Group Policy Settings screens to create custom elevation rules or modify existing ones for your
environment. The Advanced Policy Settings tab can also be used to modify the settings for advanced features
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at the GPO level. These features include client deployment settings, client data collection settings, instant
elevation settings, self-service elevation request settings, and privileged application discovery settings.
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About us
Ab o u t u s

We are more than just a name
We are on a quest to make your information technology work harder for you. That is why we build community
driven software solutions that help you spend less time on IT administration and more time on business
innovation. We help you modernize your data center, get you to the cloud quicker and provide the expertise,
security and accessibility you need to grow your data-driven business. Combined with Quest’s invitation to the
global community to be a part of its innovation, and our firm commitment to ensuring customer satisfaction, we
continue to deliver solutions that have a real impact on our customers today and leave a legacy we are proud of.
We are challenging the status quo by transforming into a new software company. And as your partner, we work
tirelessly to make sure your information technology is designed for you and by you. This is our mission, and we
are in this together. Welcome to a new Quest. You are invited to Join the Innovation™.

Our brand, our vision. Together.
Our logo reflects our story: innovation, community and support. An important part of this story begins with the
letter Q. It is a perfect circle, representing our commitment to technological precision and strength. The space in
the Q itself symbolizes our need to add the missing piece — you — to the community, to the new Quest.

Contacting Quest
For sales or other inquiries, visit https://www.quest.com/company/contact-us.aspx or call +1-949-754-8000.

Technical support resources
Technical support is available to Quest customers with a valid maintenance contract and customers who have
trial versions. You can access the Quest Support Portal at https://support.quest.com.
The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours
a day, 365 days a year. The Support Portal enables you to:
l

Submit and manage a Service Request

l

View Knowledge Base articles

l

Sign up for product notifications

l

Download software and technical documentation

l

View how-to-videos

l

Engage in community discussions

l

Chat with support engineers online

l

View services to assist you with your product
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